Accessible UML Reference Manual


Accessible UML
Introduction
Accessible UML is a tool to allow blind software engineers, students and screen-reader users to access UML diagrams produced by common UML tools. It supports UML Class diagrams, Use case diagrams, Sequence diagrams and State Chart diagrams exported from Poseidon UML (or any other tool producing XMI version 1.2 using NetBeans XMI Export version 1.0). 

It is based on work performed under the auspices of the European Union TeDUB project, http://www.tedub.org.

Opening a diagram file

When the application starts up, select File and Open to import a UML diagram. A sample of each diagram type can be found in the samples directory (c:\program files\accessibleuml\samples). These are taken from the UML specification from the Object Management Group.
UML diagrams can be created using the Poseidon UML tool. This is free for the Community version, which supports creation of the diagrams supported by Accessible UML. It can be obtained from http://www.gentleware.com/. You will also need a Java Run-time Environment to use Poseidon UML. You can obtain one from http://java.sun.com/ if you do not already have one installed. 
After creating a UML diagram in Poseidon UML export the diagram by selecting File and Export Project to XMI.  The file should have a “.xml” or “.xmi” file extension. You can then import it into Accessible UML. 

All the diagrams are supported through the same user interface. One UML model file can have many diagrams in it because a complete UML model models an entire computer system, so needs to contain many types of diagram.

Exploring the diagram

Accessible UML is shown in Figure 1. 
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Figure 1: Accessible UML
The system has a menu bar with the following items: File, Edit, View, Bookmarks, Options and Help. Pressing Alt with the first letter of the corresponding menu word can access this menu option.

There are 6 separate fields which will give information about the current node, the connections, annotations, node information, connection information and the connected nodes that can be explored by moving the joystick around the current node.  You can switch between different fields by pressing the tab key. 

At the top the first field, “Current Node”, shows the current item you are inspecting, for example a Class in a Class diagram or a Use Case in a Use Case diagram. The other five fields give information about the current node. 

The first field is the “Current Node” field. It holds a list of the nodes in this diagram at this level. 

You can move from one node to another in this list using the cursor keys or pressing a character to go to the nodes with that initial letter. A note plays when you reach the end of the list. The cursor keys work in the same way as they do when moving through the tree structure in Windows Explorer:

The left and right cursor keys move you through the different levels of the hierarchy (if available) and the up and down cursor keys move you through the list of items in the current level.
Nodes can have parents and children. For example, states can have sub-states. Multiple diagrams in the same model have their own parents. To move to the parent of the current node, press the left cursor key. To move to the first child of the current node, press the right cursor key. A note plays when you cannot go up or down any further.

The second field is the “Node Info” field and holds information about the current node, for example any operations or attributes if the node is a class. Once this field is selected with the tab key or by pressing alt plus I, you can scroll through the nodes with the cursor keys up and down to check the node information.

The third field is the “Connections” field. It holds a list of the nodes connected to this one in the diagram, not including parent and child nodes.  Once this field is selected with the tab key, or with alt plus C, you can move up and down this list with the cursor keys. Information about this selected connection, if there is any, for example multiplicity or direction is available in the “Connection Info” field. 

When in the connections field, pressing the space key will bring you to the selected node (which is then the current node). 

The fourth field “Connection Info” holds information about the currently selected node, if there is any available, for example the multiplicity and direction. This field can be activated by pressing the tab key, or by pressing alt plus T.

The fifth field is the “Annotation” field. It provides any text notes attached to the node. You can edit these: they are updated automatically. The annotation field can be activated by pressing the tab key, or by pressing alt plus A

You can retrace your steps at any point by pressing Alt and the left cursor key. This works just like the back function in a web browser. There is also a forward function, Alt and the right cursor, which works in the same way.

If you become lost, you can return to the top node in the diagram by pressing Control and Home.

Structure of a UML Model

You will quickly notice that everything except the simplest UML diagram has a complicated structure. This is how Accessible UML lays out information so you can find it:

· The top node of the model is a Model node and contains all of the information for the system.

· The first children of this node are all the diagrams in the model. Each diagram node links to the actual content nodes and provides any diagram-level information, such as text on the diagram itself.

· The other children of the model are the contents of the model, such as individual Class or Actor nodes. Each may or may not appear in a diagram (or several diagrams). 

· Class and Use Case diagrams are the simplest: they appear as the first children of the top Model node, and their contents will be found as children or the top Model node.

· The contents of State Chart diagrams will be found as children of Class nodes, and there may be many levels of them depending on how the diagram is nested.

· The contents of Sequence diagrams are laid out very differently. They are found under Collaboration nodes. The first child is always the first one in the sequence, and they are laid out after that in order of name and time.
Using the joystick

The other field, “Joystick”, shows what node, if any, is located in the direction currently indicated by the joystick. You do not have to switch modes, it updates continuously. If you want to go to the node indicated by the Joystick field, click the trigger on the joystick. There is one exception to this: if you are in the Connections list, the trigger takes you to the node indicated on that list.

Other joystick buttons are shown in Figure 2. The keys on the joystick can be used to switch between the different fields. The hat switch allows you to move up and down lists and up and down in the diagram hierarchy, as shown in Figure 3.

There are eight keys on the joystick which to which the following functions are assigned: 

The button to the upper left of the hat switch will activate the current node list. The button to the lower left of the hat switch will activate the node information box. 

The button to the upper right of the hat switch will activate the connection list, and the button to the lower right of the hat switch will activate the connection information.

There are also four buttons at the console of the joystick. The button on the upper left will activate the map function which will be explained later in this manual; the button at the lower right side will activate the joystick field; the button on the upper right side will activate the annotation information.
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Figure 2: The Saitek joystick keys
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Figure 3: The operation of the hat switch

Finding nodes in the diagram

There is a search function for nodes: simply select “Find” from the “Edit” menu or press ctrl plus F, and enter your search criteria. This will take you to the next matching node. The search is case-insensitive – so you can use “case” or “Case”.  If a matching item is found it will become your current item. The search engine starts presenting the first item that is found according to the search criteria. If this is not the desired item, you can press F3 till to find the next item that meets the search criteria. You can also repeat the ‘find’ query with more specific criteria till the desired item is met. 
In the dialogue window there is also a possibility to search on items and or annotations. The default is a search on items and annotations. If you want to search on items only, select the annotations condition and deselect this tick box by pressing the space bar so only the items are ticked on. If you want to search on annotations only, select the items condition, and deselect this tick box by pressing the space bar, so only the annotation tick box is checked on.

Different views of the diagram (all diagrams)
You can change the information presented to you with the options under the “View” menu.

Selecting “Text View” gives you a text-only description of the diagram. This is a hypertext document: if you move the cursor to a link to a connected node or to a link to a parent and press the return key, you will be moved to the first line of that node. You can leave the text view function by pressing the escape button, or by selecting the OK button with the tab key and pressing enter. 

If you are in a Diagram node you can see its contents in Accessible UML by selecting “View” and “Graphical View”. This requires you to have the Adobe SVG viewer installed. You can leave this function by pressing the escape button, or by selecting the OK button with the tab key and pressing enter. 
If you have a joystick, you can bring up a map function by selecting “View” and “Map View”. You have to be in a Diagram node to activate this function. You can then move the joystick around the whole area of the diagram, and be presented with whatever is at that location in the diagram. Press the trigger to go straight there. Notice that this function gives you an idea where things are, but not about their connectivity. You can leave the map function by pressing the escape button, or by selecting the OK button with the tab key and pressing enter. 

Finally, you can select what types of node you wish to see with “View” and “Select items to view”.  This provides you with a list of nodes, and you can select or unselect which types are shown. By default every type is selected and displayed. If you unselect some types, they don’t appear when you move around the diagram. This is useful if, for example, you are examining a Use Case diagram and want to go through all the Use Cases without concerning yourself with the Actor use cases.

Navigating by compass directions (number pad)

Make sure that the number lock is on, and you can use the number pad to move around the diagram. If the 5 key is the current location, each of the number keys 1 to 8 move you to the room in that direction: if there is no room in that direction you will hear a warning sound. You can move in the cardinal compass directions (North, South, East and West) and the diagonals (N.W., N.E., S.E., and S.W.) Pressing the 5 key takes you to the list of nodes so you can hear the name of the current node.
The compass keys have a special dual purpose in Sequence diagrams. In these diagrams, when you have navigated to a particular message, the North and South directions take you backwards and forwards and time. West and East movement is possible if the message connects two objects. 
Jumping around the diagram 

You can record bookmarks for nodes in the diagram so you can return to them quickly. This is useful if, for example, you are examining two connected nodes and want to quickly switch between them.

You can add a bookmark with the “Add bookmark” option under “Bookmarks”. These are added to the “Bookmarks” menu. There is a quicker way to do this: Control and Shift and a number key sets that number to be a bookmark for the current node. Control and a number key goes to the bookmark for that number.  Control and B adds a bookmark to the next space.
Editing and saving changes

You can change the name (but not the type) of nodes in the diagram to something more helpful for you. Select “Rename node” from the “Edit” menu and enter the new name for the node.

You can save your annotation, bookmarks and any name changes by saving the diagram. Select “Save as…” from the “File” menu to save your file. It is saved in the Accessible UML format – not the XMI format – so you will not be able to import it back into any other application. By default it has the same name and the extension “.tdd”.
Options

You can turn all the sounds in the program on or off by selecting the menu “Options” and “Sounds”. A check indicates the sounds are on. You can alter the volume of the sounds that are played by joystick movement by selecting “Options” and “Sound volume”. This produces a slider that alters the volume.

Control reference

All the keys in the application. Of course, you can access the different fields in the form with their access keys, for example Alt and A for Annotation.

	Key
	Action

	Left cursor
	Go up a level of the hierarchy

	Right cursor
	Go down a level in the hierarchy

	Up cursor
	Go to the previous item in a list

	Down cursor
	Go to the next item in a list

	Alt + Left cursor
	Go back

	Alt + Right cursor
	Go forward

	Control + Home
	Go home

	Control + Shift + number key
	Set bookmark

	Control + Shift + B
	Set bookmark (next available space)

	Control + number key
	Go to bookmark

	Control + F
	Find a node

	F3
	Find next node
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